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Description of Above & Beyond
Use Above & Beyond to maximize each day in your life! Its unique dynamic scheduling 
makes it easy to arrange your plans and stay on top of tasks, projects and calendars.    
Recurring items of all types appear automatically.    Full week and month-at-a-glance views.    
You can print schedules to take your plans wherever you go.    Logs all completed items.    
Launch programs from schedules, or pop-up alarms. Plus an auto-dialer, task timer, and 
more.    

With Above & Beyond, you can plan time for everything you want to do.

Above & Beyond in a LAN environment adds even more benefits. Managers can balance the 
work-load of their staff, assign new items and prioritize work, as well as check task-
completion status. Secretaries can post phone messages for calls to be returned, and 
monitor multiple schedules to know who is where when.    Above & Beyond also includes a 
meeting-maker for group scheduling.

Above & Beyond streamlines workflow and productivity soars! 

Powerful Advanced Scheduler
Above & Beyond leads the world's most advanced time management systems. It's amazing 
effectiveness is primarily due to what is called dynamic scheduling. In the section Dynamic 
Scheduling that follows, you'll start to discover how much this can benefit you.

Share the Benefits
Certainly many people you know could benefit from using this High Achievement System.    
We encourage you to make copies of Above & Beyond, and give them to others to evaluate.

Price
Above & Beyond for a single user is    $149. LAN systems for any number of users are also 
available. Call 1Soft at 800/326-4391 for additional information on specific size 
configurations.

Send your comments and suggestions
Product questions and requests for enhancements are welcomed (and always considered). 
Please address your comments to:

1Soft Corporation
Product Comments

Post Office Box 1320
Middletown, CA    95461





Registering Above & Beyond
Be sure to register Above & Beyond by ordering a license. To register, select the Options 
menu and choose Order an Above & Beyond License or choose Order a pre-paid Above & 
Beyond License.    Use "pre-paid" if you have a registration certificate, which is the case if 
you bought the software package through a dealer.    Simply fill out the form, and click on 
"Print" to send the form to your printer.    Send both copies with your check or credit card 
number and expiration date.    Complete instructions appear on the printed form.    

If paying by VISA, MasterCard, or American Express, you can FAX your order form to 707-
987-3150.    If you have questions about your order you may call 1Soft    Corporation at 800-
326-4391.    

The Complete Package
When you purchase an Above & Beyond license, you will receive the complete package 
including the spiral bound User's Guide and program disks in both 3.5" 720K and 5.25" 360K 
formats.

As a registered (licensed) user, you'll also receive a personal User ID and substantial 
discounts on product upgrades.



Distribution Information
You are authorized to make only exact copies of Above & Beyond files to give to others for 
evaluation purposes. Modifying the original content in any way at any time is strictly 
prohibited. This also prohibits temporary modification while the binary data is in RAM. 
Archiving (compressing) distribution files is permitted only for efficient transmission and 
must not alter the original content.

Only individuals licensed by 1Soft Corporation are authorized to use Above & Beyond files on
a continuing basis. Continued active use without registration is prohibited. No other parties 
have been authorized to sell or grant licenses. Various shareware distributors have been 
authorized to sell disks containing Above & Beyond. They are selling disks and a distribution 
service only. They are not selling Above & Beyond licenses.

Liability Disclaimer
1Soft Corporation specifically disclaims any warranty of merchantability or fitness for a 
particular purpose. With respect to defects in its programs and supporting materials and 
service, in no event shall 1Soft Corporation be liable for any loss of profit or any other 
commercial damage, including but not limited to special, incidental, consequential, or other 
damages.

Copyright/Trademark Information
The software files that comprise Above & Beyond are Copyright © 1992 by 1Soft 
Corporation.    All rights reserved.    Unauthorized use is a violation of U.S. and international 
copyright laws.    1Soft and Above & Beyond are trademarks of 1Soft Corporation.



Installing Above & Beyond
The installation process allows you to select where you would like to put Above & Beyond 
files. The directory you name will be created if it doesn't already exist, and the files will be 
copied from the diskette to this target directory. If Above & Beyond is already on your hard 
disk (you downloaded from a BBS, for example) you can start with Step 3.

Step 1:Insert the Above & Beyond diskette into drive A.

Step 2:In the Windows Program Manager, Select Run from the File pull-down menu and type:

A:INSTALL

Step 3:    Create a program item (an icon) in the program group of your choice, eg. Windows 
Applications. From the Program Manager, select File, and choose New. Select Program Item. 
As a description, you might type in you name, and for the command line, state the path and 
program file, for example:    c:\ab\AB.exe.

You can also specify a datafile name such as:    c:\ab\AB.exe    Michael

The extension will be assumed as .PAK. When you omit the datafile name, the name used is 
TIMEDATA.pak by default. 

Step 4: Start Above & Beyond by selecting the icon you have created and either pressing 
Enter, or double-clicking with the mouse.

Installing Above & Beyond for a LAN Workgroup
Although you can install the program file AB.exe in a shareable directory on the server, and 
have your workstations access it there, it will run faster if installed locally. This is because 
Windows will not have to repeatedly access the server hard drive to read parts of the 
program code into memory. If installed on the local workstation, Above & Beyond will not 
only load quicker, but it will also operate at a faster, more responsive pace. This is true for 
all Windows applications. 

The installation is the same as described above in the section "Installing Above & Beyond" 
with one exception. You will want to have datafiles reside on the server's hard drive. It's 
recommended you designate an individual directory for each user. This will keep .log files 
(completed items are tracked in these files) for each user from being combined.

When you run Above & Beyond, if the directory and/or file you specify does not yet exist it 
will automatically be created for you.

Suppose you have four users: Bill, Karen, Cindy, and Michael;    and the name of your server 
drive is "J". The command lines on the workstations could be as follows:

On Bill's workstation: c:\ab\AB.exe    j:\Bill\Bill

On Karen's workstation: c:\ab\AB.exe    j:\Karen\Karen

On Cindy's workstation: c:\ab\AB.exe    j:\Cindy\Cindy



On Michael's workstation: c:\ab\AB.exe    j:\Michael\Michael



Dynamic Scheduling
Above & Beyond is designed to organize your life and maximize your productivity. It can plan
time for everything you want to do! 

Much of the superior power and flexibility of the Above & Beyond system is based on its 
unique automated scheduling of floating tasks. These schedules are so effective, they render
to-do lists obsolete. Floating tasks are to-do tasks. Unlike fixed items such as appointments, 
they don't have to be done at a precise time. Most of the items of work you do each day are 
floating tasks. These tasks have an anticipated duration to be planned for, but they can be 
performed during some range of hours. Automated scheduling of to-do (floating) tasks 
allows you to plan more precisely than you could with a list, and see clearly how your time is
being allocated. The benefit of using these flexible dynamic schedules is tremendous. The 
following pages detail some of the advantages.

Productivity Gains Through the Day
The best way to illustrate how you can save time throughout the day is to look at a typical 
day, and compare using a to-do list to using Above & Beyond's dynamic schedules. If your 
to-do list has 100 items, and the average task is 15 minutes, then every 15 minutes or so 
you have to stop and decide what to do next. Suppose you spend only one second 
considering each item as you scan a to-do list of 100 items. That's over a minute and a half 
for each scan. If you finish 40 items you will have repeated this scan 40 times in the day, 
spending an hour in the process. This lengthy scanning is eliminated with Above & Beyond. 
You glance at your schedule, see what's next, and begin it without hesitation. You finish 
these 40 items an hour sooner!

And if circumstances require changing your plans during the course of the day that's easy 
with Above & Beyond. If you're at your PC, the schedule on-screen instantly reflects your 
changes, or if you're using a printed Above & Beyond schedule you can make your changes 
on paper, marking up the alterations in your own shorthand.

Having your workflow streamlined leads directly to much higher achievement every day. 
Above & Beyond will boost your performance and rewards in all your pursuits. And provide 
you with more time for leisure pursuits!

Rewards of Higher Achievement
Imagine saving 60 minutes every day! That's 365 hours a year. What would you do with an 
extra 365 hours a year? You've gained the equivalent of nine 40-hour work-weeks. 

Depending on your lifestyle that might translate to an extra two months of vacation, a 18% 
boost in billable hours, self-employment earnings, or commisions, or a hefty raise at your 
next performance review.

Above & Beyond Breaks New Ground
Above & Beyond introduces a new, and more effective way to manage your time. Instead of 



having tasks merely listed in a to-do list, they can be scheduled in the available time 
between the appointments on your calendar. There are several advantages to this approach:
a unified view, time budgeting, time-frame targeting, transition smoothing, and more. 

Integration: a Unified View
Having a unified view means that you don't have to split your attention between your 
appointment calendar and to-do list. Everything you have planned is arranged in the day's 
schedule. No longer do you have to split your attention; you can focus. 

Time Budgeting
Tasks will be scheduled automatically.    At a glance, you can see how much can be 
accomplished and how much space remains in a given day. This minimizes the number of 
surprises and crises that arise when insufficient time remains to accomplish high priority 
tasks before a deadline. And since a schedule is much more precise than a to-do list, you 
can more easily make and keep your commitments to others. You can tell them in advance 
exactly when you plan to have something done. 

Doing it All
One of the most frequent causes of stress we have all experienced is the feeling of having 
too much to do. More specifically, we have a lot to do, and aren't sure if we'll get it done in 
time.    It's this doubt and worry that brings on stress.    Now you can see exactly what you 
have to do and how long it's going to take. Then if it cannot be accommodated before 
deadlines, you can defer lower priority tasks. A renewed sense of confidence in knowing 
what you can get done, and when, will greatly lower your stress level. 

Forget it Not
Another source of stress is worry over forgetting to do certain things before they must be 
done. We all use methods to combat this threat. Unfortunately the methods are not always 
reliable, and result in a certain amount of stress. The key to reducing this stress is simply 
finding a more reliable means to keep track what has to get done, and being reminded of it 
when there's time to do it (before it is too late). 

A More Exciting Life
You will naturally feel more excited about life as you put this time planning system to use. 
With a greater potential for higher productivity you can accomplish all the things you need 
to do, and find time for more of the things you want to do. 

Daily Use
You can gain most of the above benefits even if you use a PC only about twenty minutes 



each day. 

Getting Started
Enter the items you plan to do, including recurring items. This can be done very quickly. In 
the span of about 15 minutes you can probably enter 50 items. Don't forget to include the 
many things you do everyday, such as lunch. These need be entered only once; time each 
day will be reserved for them. There will be additional tasks that you'll think of later, and you
can enter them anytime. 
 
Then plan today. If today's tasks are not already in a sequence that suits you, arrange them 
and make adjustments, and then print your schedule for the day. If you have a printer, you 
can make a printed schedule to carry through the day, crossing-off items that you complete. 
New items can be noted on this same page, and entered the next morning. If you're using 
the printed schedules and only running the software once daily, you'll spend about 10 to 20 
minutes updating information by marking completed events, entering new schedule items, 
and adjusting your plans according to your latest    priorities. 

The Daily Planning Session
First, check-off the items that have been completed.    Then reschedule the tasks you didn't 
get to.    You may reschedule them to today's schedule by simply pressing F12.    Or 
reschedule to the date of your choice by clicking on that date on the pop-up calendar with 
the right mouse button.    To view that date, click with the left button.

Add New Items

Add any new items. These might be items you're carrying in your head or those you jotted 
down on yesterday's printed schedule page. 

Arrange Your Schedule

Using the keyboard or mouse, move the items in today's schedule around so that today's 
schedule best suits you. Often today's schedule will be overloaded, but you can defer items 
by rescheduling them to future days.    And you can adjust today's sequence so there are no 
conflicts, and items are in the order you desire, bringing related items together, for example.
As you make changes, you'll notice that the schedule will adjust automatically. 

Print a Schedule Report

You'll want to print off today's schedule, and normally also the extended outlook. The 
extended outlook includes a 3 month calendar, and any highlighted events for up to 90 
days.

Jot notes on your schedule report during the day; cross-off items you complete.    Use the 
extended outlook to pin-point what times are committed so you can schedule appointments 
even while away from your PC. 



Making Backups
Backing up your vital scheduling data is very important. We recommend Making daily 
backups of your data files (*.PAK files) in case a file should get lost or damaged.    Also it's a 
good idea to make at least one backup copy of the program files in    case something should 
happen to the original disk.    For more information, see Data Saving and Making Backups in 
the section entitled "Using Above & Beyond".



Schedule Notation
The first line of each schedule displays a convenient summary of the schedule shown in the 
window.    What is displayed is the day and date of the schedule, the number of items in that 
day's schedule, the amount of time taken up by the items in the schedule, and the amount 
of time left unscheduled in that day (open or free time).    On past schedules, the number of 
undone items will also be reported in the banner line.
 
If the schedule being viewed is the one for the current day, an asterisk (*) will appear after 
the date in the banner line.      
 
If the schedule being viewed is not the schedule for the present date, a number will appear 
after the date in the banner    line preceded by a plus (+) or a minus (-).    A number 
preceded with a plus indicates that the schedule being displayed is that number of days in 
advance, or in the future, of the present date.    A number preceded by a minus indicates 
that the schedule shown is that number of days behind, or in the past from, the present 
date. 

An arrow (>) will appear before the title of the item that is scheduled for the current time.    
Schedule statistics will change as items are added, deleted from or modified in a schedule or
as schedules for different days are selected.

Start Times Grayed

On today's schedule, item start times will appear gray if the start time has already past.    
Also, if you move an item to a spot where it conflicts with another item or goes outside of 
the time bounds you designated, the time will appear gray; warning you of the conflict.    
Keep this in mind when juggling items.

International Time & Date Formats

Above & Beyond supports world-wide date and time formats.    Use the Windows Control 
Panel to select your choice of time and date format. 



Selecting Schedules
The Select menu shows the commands for selecting which day to view.    Or simply click on 
the desired date on the pop-up calendar.

There are many ways to move between schedule days.    You may move ahead or back by 
days, weeks, months, or years.    No matter how far you go ahead or back in time, you can 
always return to today's schedule by simply pressing the HOME key.

Selecting a Day at a Time
Selecting a Week at a Time
Selecting a Month at a Time
Selecting a Year at a Time



Selecting a Day at a Time

There are shortcuts to selecting the schedule for date one day earlier or later than the one 
being displayed: 
 
Press the gray PLUS (+) key on the numeric key pad and the schedules will advance one day.
 
Press the MINUS (-) key on the numeric key pad and the schedules will roll back one day. 

Or with the mouse...
 
Click on the right-pointing arrow at the far right end of the horizontal scroll bar at the bottom
of the schedule screen, and the schedules will advance one day. 
 
Click on the left-pointing arrow at the far left end of the horizontal scroll bar at the bottom of
the schedule screen, and the schedules will roll back one day. 



Selecting a Week at a Time

There are shortcuts to selecting schedules weeks apart:

Press F7 to view the day one week earlier.

Press F8 to view the day one week later.

Or with the mouse...
 
Click in the gray area on the left half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.

Click in the gray area on the right half of the horizontal scroll bar at the bottom of the 
schedule window to view the day one week later.



Selecting a Month at a Time

The pop-up calendar with a mouse can be used to quickly move the display by months at a 
time:

Month to month moves of the pop-up calendar, are directed with the up and down arrow 
keys when the pop-up calendar has the focus.

Or with the mouse...

Click on the up-facing arrow at the top end of the vertical scroll bar on the right side of the 
pop-up calendar, and the calendar will advance one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed. 
 
Click on the down-facing arrow at the bottom of the vertical scroll bar at the right side of the 
pop-up calendar, and the calendar will roll back one month.    Then, click on the desired date 
in the calendar and that schedule will be displayed.    



Selecting a Year at a Time

The pop-up calendar with a mouse can be used to quickly move the display by years at a 
time:

Year to year moves of the pop-up calendar, are directed with the PageUp and PageDn keys 
when the pop-up calendar has the focus.

Or with the mouse...

Click in the gray area on the top half of the vertical scroll bar at the right side of the pop-up 
calendar, and the calendar will advance one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 
 
Click in the gray area on the bottom half of the vertical scroll bar at the right side of the pop-
up calendar, and the calendar will roll back one year.    Then, click on the desired date in the 
calendar and that schedule will be displayed. 



Inserting Items Into a Schedule
Select the date on which you wish to schedule your desired item, then double-click the 
mouse on any open space in the schedule screen (not on a existing item). (You can also 
press the INSERT key, or select the Insert command in the Edit menu and press ENTER).    A 
dialog box will be displayed which will guide you in entering the pertinent information about 
your item quickly. 
 
If you were to press ENTER, without typing any information into the dialog box, an untitled 
item would be entered in your schedule for that day at the earliest free space with a 
duration of 10 minutes. 

Entering Item Title
Entering Item Duration
Entering Notes
Entering Item Date
Scheduled / Unscheduled Items
Begin Time and Floating / Fixed
Time Bounds
Setting Alarms



Entering Item Title

The title (description) of your item can be up to 365 characters long.    When you have 
entered the title of your item, press the TAB key to advance the cursor to the next text box.   
Note: You may view the entire text of a long item title by selecting the View command 
button.



Entering Item Duration

Here is where you enter the amount of time you think a task will take. If you are uncertain of
how much time the item will take, your best estimate will still be helpful for planning.
 
You may enter complete times like "2:00" for two hours or "1:45" for 1 hour and 45 minutes, 
or you enter short forms.    Numbers 1 through 4 are interpreted as hours, 5 through 99 are 
interpreted as minutes, while entering 100 through 2359 will be assumed to be hours and 
minutes. Therefore, 3 will appear in the    text box as "3:00", 23 will appear as ":23" and 93 
will be interpreted as 93 minutes, which is 1 hour and 33 minutes.    You may enter durations 
of up to 24 hours.    An item with duration zero is called a "note".



Entering Notes

To flag an item as a note, either type "note" or the digit "0" (zero) in the Duration box.    
When the item is inserted into the schedule, the word "note" will appear on the right side of 
the description.    If you choose to make the item an unscheduled item (as described in the 
"Scheduled / Unscheduled Items" section below), then the item will appear at the top of the 
day's schedule with the word "note" on the left, where the begin time would ordinarily be. 

A shortcut for entering notes into your schedule is to press ALT+INSERT or select "Insert 
Note Item" in the Edit menu.    This will bring up a definition dialog box for a new 
unscheduled item with duration zero (i.e. a "note").    As with any unscheduled item, notes 
will not conflict with scheduled items nor be calculated into the workload by the color 
utilization calendar.



Entering Item Date

This is the date on which your item is to take place.    The date of the schedule which you 
selected when you called up the definition (insert) dialog box, will automatically appear in 
this box.    If you decide that you'd like your item to be scheduled on another day, enter that 
date here. 
 
The date may be entered as "month/day/year" with slashes separating the month, day and 
year or you may use hyphens, periods or blanks as separators.    Examples: 
 

6-23-90            6/23/90            6 23 90 
 
You need use only two digits to specify the year.    Specifying values between "90" and the 
"99" are assumed to be years between 1990    and 1999.    Specifying values from "00" to 
"68" are assumed to be years between 2000 and 2068. If you omit the year, (e.g. 6/23) the 
year will be assumed to be the next occurrence of such date between the current date and 
the end of next year. 
 
You may alternatively enter the name of a weekday.    The date of the closest future weekday
will be assumed.    You have the option of typing the entire name of the day, such as 
"Monday", "Thursday", or "Saturday", or typing in an abbreviation , like "Mon", "Th", "F", or 
"SA". 



Scheduled / Unscheduled Items

The "Scheduled" box gives you the option of having your item appear on your schedule with 
a begin time, or you may elect to have it appear    without a time associated with it, thereby 
making it an "unscheduled" item.    Designating your item or items as unscheduled is a 
convenient way to post notes or comments on your schedule. 
 
When a new item is inserted, the default setting is that it is a "scheduled" item.    To 
designate this item as "unscheduled", click the mouse on the "scheduled" check box. To 
replace the X, and make this a "scheduled" item, simply click the "scheduled" check box 
again. 



Begin Time and Floating / Fixed 

When you leave the "Begin time" text box empty, the "Floating" option is automatically 
selected. "Floating" means your item can take place over a range of time during your day. 
The item will be inserted into the schedule at the earliest open time, taking into account the 
duration of the item, the bounds you specify, and any other items already scheduled.

The scheduler will not alter the sequencing of items without your direction. Because of this, 
you can prioritize items by sequencing them, and that sequence will be maintained. You can 
change the sequence of items by simply dragging them with a mouse (or using the 
commands in the Juggle menu).
 
The dynamic scheduler    will do much of the scheduling work for you. To maximize the power
of the dynamic scheduler, omit the begin time for all those tasks which have a flexible start 
time.    Enter a time in the "Begin Time" box only if an item must begin at a specific time, 
such as a lunch date or meeting.    As the begin time is entered, the "Fixed/Floating" option 
automatically switches to "Fixed". 
 
In 12-hour format, times may be entered as "3:00" for 3 o'clock pm, "9:45" for 9:45 am or 
"6:3" for 6:30pm.    If no "a" (am) or "p" (pm) is typed after your time, it will automatically 
appear between 8:00am and 7:59pm. Typing "9:30" into the text box will appear as "9:30a" 
and "6:20" will appear as "6:20p".    You may also enter numerals only, leaving out the colon 
completely.    Typing "4" will appear as "4:00p" and "912" will appear as "9:12a". 

24-hour time format is also supported: "5:00" (or "0500") for 5am and "17:08" (or "1708") 
for 5:08pm.    

Use the Windows Control Panel to select 12/24-hour and international time formats. 



Time Bounds

You may select a time range in which you would like to have an item scheduled.    For 
example, if you need to make a phone call to a colleague who will only be in his office 
between 9:00 and 11:30am tomorrow, enter these times in the boxes labeled "Earliest" and 
"Latest".    The dynamic scheduler will schedule "floating" items within these specified 
bounds. 
 
For items with a begin time the "Bounds" boxes will be seen in gray and will be inactive. 



Setting Alarms

In the Insert dialog box, click on the Alarm check box (or press ALT+A).    This will place an X 
in the check box, to show that the alarm is now on, and will also bring up the Alarm dialog 
box.    In the Alarm dialog box, you have the opportunity to set the alarm to go off either 
before or after an item is scheduled to begin, or before or after an item is scheduled to end.   
You can also indicate the amount of time (up to 99 minutes) before or after the item that you
would like the alarm to go off. 
 
If the "Begin time" box is marked with an "X", the alarm will sound before (or after) your 
item is scheduled to begin.    Click on the check box to remove the "X".    Click a second time 
to replace it.    You may elect to have both the "begin time" and "end time" boxes marked so 
that the alarm will go off twice, both before the item begins and before the item ends (or 
after, if "After" is selected).    
 
When the alarm sounds, a message box will appear on the screen alerting you to the 
starting or ending time of the item.    The alarm will chime every 60 seconds until you 
acknowledge it.    You will be asked if you would like the alarm repeated, and if so, when. 
 
Selecting "OK" will set the alarm with the information you have given it and bring you back 
to the definition dialog box.    Select "OK" again and the item will appear on your schedule 
with "-a" after it.    This indicates that    the item has an alarm set.    An item followed by "-ar" 
indicates that the alarm has gone off and has been set to repeat again later today.    An "-ax"
indicates that the alarm has gone off and will not be repeated today.
 
In the Alarm dialog box pressing ESC will cause the changes just entered to be cancelled,    
however, the alarm will still be set.    Selecting "Cancel" will    have the same effect.    
 
To disable the alarm, you can delete the "X" from the check box to the left of the "Alarm" 
command button in the main dialog box.    Do this either by clicking on the check box or by 
putting the cursor next to the check box with the TAB key, then pressing the SPACEBAR.

Alarms can be just as easily set on recurring items, and the alarm will go off each day an 
instance is scheduled.



Recurring Items
If you have an item that occurs on a recurring basis, it is not necessary to go to each date to
insert the item. While working in the definition dialog box, simply click on the "recurring" 
command button or press ALT+R. This will bring up another dialog box in which you may 
designate how often and on which days you'd like the item to appear on your schedule.

The following topics explain the options in the "Recurring" dialog box. Once you have 
finished your session in the "Recurring" box, click on "OK" (or TAB to the OK    button and 
press ENTER).    This will return you to the definition dialog box.    The "Date" button no longer
contains a date but is marked "Recur'ng".    On your schedule the item will be followed by "-r"
to indicate that it is a recurring item. 
 
Note: While working in the "Recurring" dialog box, you may decide that you don't want your 
item to be recurring. Press ESCAPE (or TAB to the "Cancel" button and press ENTER).

Unlike most scheduling programs, 1Soft schedulers allow you delete or change all 
occurrences (instances) of a recurring item in a single operation, so you don't have to delete 
each and every occurrence one by one. The Delete All Occurrences command is in the Edit 
menu, and its shortcut is CTRL+DELETE.

Recurring Daily
Recurring Every __ Days
Recurring Weekly
Recurring Every __ Weeks
Recurring Monthly
Ordinal Weekdays
Recurring Every __ Months
Recurring Annually
Entering Birthdays
Recurring to Non-recurring
Delete All Occurrences
Exceptions to Recurring Items



Recurring Daily

When the "Recurring" dialog box first comes to the screen, the "Daily" option button is 
selected.    Click on, or press TAB to move from the "Daily" button to the text box titled 
"Starting".    The date in this box will automatically be the date of the schedule you are 
presently working with.    You can change this date to a later date by entering it as 
"month/date/year".      
 
Click on, press TAB again to move to the text box titled "Ending". This text box will be blank, 
and if left blank will cause your item to be inserted into every daily schedule indefinitely.    
You may type in the date of the last day that you would like your item to take place.    Click 
on "OK," or press TAB to select the "OK" command button and press ENTER. The "Recurring" 
dialog box will disappear and the definition dialog box will return to the screen.



Recurring Every __ Days

Your item may not need to take place daily but every so many days.    When in the 
"Recurring" dialog box, click on (or press the DOWN or RIGHT arrow key to select) the button
labeled "Every ___ Days".    You may chose to keep the default setting (2) or you may enter 
any number up to 99.    Press TAB    to bring the cursor to the text box and type in the 
numerals. 
 
Specify "Starting" and "Ending" dates as with Daily items and press ENTER when you are 
finished.    Remember that leaving the "Ending" text box blank will cause your item to be 
scheduled into the future indefinitely. 



Recurring Weekly

To schedule a weekly item, in the "Recurring" dialog box, click on the "Weekly" button, then 
click on the check box for each day on which you want the item to be scheduled. 
 
If you are not using a mouse, press the DOWN arrow key twice to select the button labeled 
"Weekly", then TAB to the series of seven check boxes labeled for the days of the week.    
The cursor will appear as a gray vertical line to the right of the check box labeled "M".    Press
the space bar to fill in this box with an "X."    Press the RIGHT (or LEFT) arrow key to move 
the cursor along the row of boxes. 
 
You may also choose to leave all the day-of-the-week check boxes blank and tab directly to 
the "Starting" text box.    This will cause your item to be scheduled once a week on the week-
day that your "Starting" date falls on.    For example, if the "Starting" date falls on a Monday, 
then your item will be scheduled each week on Monday. 



Recurring Every __ Weeks

To schedule an item at an interval of every two or more weeks, click on (or use the DOWN 
arrow key to select) the button labeled "Every ___ Weeks".    The default setting here is 2.    
You may enter any number up to 99.    Note: Entering the number "1" in this text box will 
cause the button selection to change automatically from "Every _1_    Weeks" to "Weekly".      
 
As with Weekly recurring items, you may check the boxes to indicate on which day(s) of the 
week the item will occur.    As stated earlier, if you chose to leave all of the day-of-the-week 
boxes unchecked, your item will be scheduled on the day of the week that the "Starting" 
date falls on. 



Recurring Monthly

Items may be scheduled once, several or many times each month.    In the "Recurring" dialog
box, click on (or press the DOWN arrow key to select) the button labeled "Monthly on...". 
 
Using a mouse, simply click on "Cardinal Month Days", then click on the check boxes for 
each of the desired days. 
 
Without a mouse, press TAB to select "Cardinal Month Days".    Press TAB to move the cursor 
down to day "1" in the calendar. The cursor is now a dotted gray outline around the check 
box. Mark the boxes you wish by pressing the SPACEBAR.

Using "Cardinal Month Days", if all the check boxes are left blank, the item will be scheduled 
each month on the same day of the month as the "Starting" date. 



Recurring on Ordinal Weekdays

You may want to schedule your item to take place on a certain day each month; for example,
the first Friday and the second Wednesday of every month.    To do this, select "Monthly 
on..." and click on the button labeled "Ordinal Weekdays" (or press ALT+O).    You can move 
around this calendar and mark the boxes in the same way as with "Cardinal Month Days".



Recurring Every __ Months

To schedule an item at an interval of every two or more months,    in the "Recurring" dialog 
box, select the button marked "Every ___ Months...". The change the default setting of 2, 
click in, or press TAB to move the cursor inside the text box. 
 
As with Monthly recurring items, select the desired "Cardinal Month Days" or "Ordinal 
Weekdays". 



Recurring Annually

To schedule an item once a year, in the Recurring dialog box select the button labeled 
"Annually".          
 
Click on (or press TAB to move the cursor to) the "Starting" and "Ending" text boxes.    Fill in 
the dates of your choosing and click on "OK", or press ENTER.    The item will be scheduled 
each year on the date entered in the "Starting" text box.



Entering Birthdays

To enter birthdays use "Insert note item".    Enter the desired text, then click on "Recurring".   
In the recurring dialog box, choose "Anually".    Specify "Starting Date" as the next 
occurrence of the birthday; NOT the actual birthday.    The reason for this is that    the actual 
birthday may be outside of the range of Above & Beyond dates.



Recurring to Non-recurring

To change a recurring item to a single-occurrence item, in the definition dialog box click on 
(to remove) the "X" from the check box to the left of the "Recurring" button.    Without a 
mouse, TAB to put the cursor on the right side of the check box, and press the SPACEBAR. 
Each time you click on the check box or press SPACEBAR, the recurring status of the item 
switches, from recurring to non-recurring and back again.    An "X" in the check box indicates 
that the item is recurring, while an empty check box indicates that the item is a single-
occurrence item. 
 
When you change the status of an item to non-recurring this way and then press OK, all 
occurrences of the item will be deleted with the exception of the one instance that is 
selected. 



Delete All Occurrences

There are two methods you can use to remove all occurrences of a recurring item.    The first 
is to select any occurrence of a recurring item on any schedule, then select "Delete All 
Occurrences" from the Edit menu.    
 
The second method is to first choose the "Alphabetical Items List" in the View menu (ALT+V, 
A), select the recurring item on the list, press the DELETE key. 



Exceptions to Recurring Items

Perhaps a meeting which is normally scheduled to take place on the first Monday of every 
month will be moved to the following Tuesday because of a holiday that Monday.    Or 
perhaps your daily lunch, normally at 12:30 needs to be extended next Friday to 90 minutes 
and moved to 12:00 for an achievement awards luncheon.

There are quick and easy ways to make exceptions; but first, an overview: Simply select any 
standard instance of the recurring item on any schedule day and bring up the definition 
dialog box by pressing ENTER or by double-clicking on the item.
 
Now, click on the Next button (or press ALT+N) to advance the date shown above the Next 
button to the date of the next occurrence of the item.    Similarly, click on the Prior button (or
press ALT+P) to display the date of the previous occurrence of the item.    When the date of 
the item occurrence that you wish to modify is showing, you may...    
 
            Press ALT+C      --    To    Cancel (delete) this occurrence of the item or...

            Press ALT+X      --    To    indicate that this occurrence of the item
is different in some way, then... 

              
Make the desired changes in the upper portion of the definition dialog box and select OK.    
The schedule for the date of the modified occurrence will appear on the screen. To the right 
of the item title will be an "-rx" to indicate that this is an exception to a standard recurring 
item. 
 
Note:    If you would like the modifications entered to become the new standard for the 
recurring item press ALT+S (for Standard)    while still in the definition dialog box. 

To quickly Cancel (Delete) ONE instance of a recurring item, select that item in the schedule 
on day you want it cancelled. Then press delete.

To quickly change the date of one instance of a recurring item, select the instance, and 
simply move it to another day. 

To quickly change the duration (or any other details) of one instance of a recurring item, 
select the instance and press ENTER (or double click on the item.)    When the Refine dialog 
box appears, press ALT+X (or click on the Exception option.)    Change the information and 
press OK.

When the Standard (ALT+S) option is on, changes in the Refine dialog box affect all standard
instances.

Changes in the Recurring dialog box (daily, weekly, etc.) affect only the standard instances.



Changing Item Information
To change any information for an existing item, first double-click on the item description line 
on the schedule window (or select the item and press ENTER).    Then, click on (or TAB to) the
appropriate box and enter the changes.    If the desired changes are to the "Recurring" or 
"Alarm" settings, select these dialog boxes by clicking on "Recurring" or "Alarms".

To save the changes select OK.    To return the item to the schedule without any of the 
changes taking effect, press ESCAPE or click on "Cancel" (or TAB to "Cancel" and press 
ENTER).    

To make changes to a recurring item, select any STANDARD instance of the item.    If you 
select an instance of the item that has been designated as an exception, then the changes 
will only affect that occurrence of the item. 



Deleting Items
Click once on the item in the schedule (or use the arrow keys) to select it, then press the 
DELETE key (or press ALT+E,D).    A message will appear, asking you to confirm the delete 
command.    Click on "Yes" (or TAB to "Yes" then press ENTER) and the item will be removed 
from the schedule.    If you click on "No" (or press ENTER with "No" selected) the item will not
be deleted. 



Toggling Between Two Views
Just above the vertical scroll bar is a small box with an upward pointed triangle in it.    
Clicking on this triangle will switch to the view mode that was in effect immediately before 
the current view mode.    If there is no previous view mode, the Alphabetical Items List view 
will be selected. 
 
Using this feature, you can switch back and forth from single window to Week at a Glance or 
Multiple Windows views and back again easily. 



Juggling Items
Once an item is inserted into your schedule, you may move it to a different position within 
that schedule or move it to the schedule of a different day.    If you are not using a mouse, 
see "The Juggle Menu" in the Menu Commands section, or pull-down the Juggle menu and 
you'll see the keyboard-equivalent shortcuts. 
 
Using a mouse, click to select the item you wish to move, then simply drag the item up or 
down within the schedule. When you move a "floating" item up or down on the schedule, the
begin time of the item will adjust automatically. Even if you have designated an item to take 
place at a fixed time, it is possible to move that item up and down in sequence on the 
schedule, however the time you specified remains the same. 
 
To move a selected item to another schedule, simply click with the right mouse button on 
the desired target date in the pop-up calendar. This is the quickest and easiest way to 
reschedule an undone task to another day.
 
Or, while viewing multiple schedules, drag the selected the item from one schedule window 
to another. 
 



Highlighting an Item
For emphasis, you may wish to highlight certain items on your schedule. Highlighted items 
appears in the schedule as underlined and will be printed when "Extended Outlook" is 
selected.    See the Print commands in the File menu for more information on the Extended 
Outlook. 
 
The "Highlight Item" command will underline the currently selected item.    A shortcut for this
command is to press F3 while in the schedules window.    Press F3 again to remove the 
underline.    Items you wish to appear in Month-at-a-glance view must be highlighted.



Printed Schedules
You may print reports that list your schedule for the present day and beyond;    plus a three 
month calendar. This allows you to see openings for appointments while away from your 
computer. All highlighted (underlined) events for the next three months also may be listed 
by choosing the Extended Outlook option. See the Print commands in the File menu for 
details. 

Printed schedules have vertical spacing proportional to time span.    This makes it easier to 
see the relative durations of each item.    Items of longer duration will have more blank space
below the row they appear on, than those of shorter duration.



Data Saving and Backups
To minimize data loss from unexpected natural disasters such as power interruptions, 
schedule changes are saved every 60 seconds in the file TIMEDATA.PAK.    Should a power 
interruption occur, you would lose only the changes you made within the last minute.

As an added precaution,    ten backup files are maintained which contain your previously 
saved scheduling data.    Just before TIMEDATA.PAK is updated, it is copied to a file named 
"TIMEDATA.BKn" where "n" is a digit form 0-9.    Just the oldest of these files is updated each 
time on a rotating basis.

There are few things more important than your data.    Especially the scheduling data you 
rely on to plan your future and to track your accomplishments.    On a daily basis make 
backups of    all *.PAK files as well as your archived schedules (*.LOG files). These backups 
should be made on reliable media and stored in a safe place. 



Schedule Archiving
A schedule will be "archived" when seven days have passed and all items are marked done, 
rescheduled, carried forward, or deleted. That is, nothing remains on the day, but items 
marked done. Those completed items are archived to monthly log files named according to 
the month and year.    For example: "Jan91.Log"    Note: In order to conserve RAM, there is an 
exception to the seven day wait:    If you have more than 300 items (total) in Above & 
Beyond, archiving will occur the day after a day's items have been done.

To view the archived schedules for a particular month, select any schedule in that month; 
then in the File menu choose Display Log File for Month.    (See Selecting Schedules for more 
information on how to select schedules.)    The archive files are ASCII format (text) and may 
also be displayed or printed using the TYPE or PRINT commands of DOS, Windows notepad, 
or other utility applications, including text editors.

Log files are formatted with tab-separated values so they can also be read as text files by 
spreadsheets such as Microsoft Excel and Lotus 1-2-3.    To make it simpler for you, durations 
are in one type of units: minutes.



Automatic Launch of Applications
There may be times when you want to run a program or application at a precise time 
without having to manually initiate it.    This feature is activated by either of the two 
keywords, EXEC or AUTOEXEC.    When either one of these words is included in the item title 
the feature is enabled.    You may specify parameters which will be passed to the program.    
 
You can also manually launch an EXEC or AUTOEXEC item.    Simply select the item, then 
press F5 (or use Edit: Start Item).    For details on the Start Item command see Edit: Start 
Item in the Menu Reference section.

When running in a LAN environment and viewing someone else's schedule, you may 
temporarily disable their Exec and Autoexec launching by choosing Options: Alarms Off.    
Note that the setting you select for this option on their Above & Beyond schedule affects 
only your viewing of their schedules.    That is, Exec and Autoexec will still be functional 
when they view their Above & Beyond schedules from their workstation.

The EXEC Feature

When the keyword "EXEC" is used in an item title, and the scheduled begin time for that 
item is reached, a dialog box will be displayed which has the current time and the message, 
"Ready to EXEC <program-name>."    At that time, you may choose the "yes" option to run 
the program, or choose "no" to cancel the process. If run, the item will automatically be 
marked as completed in the schedule. 

The AUTOEXEC Feature

When the keyword "AUTOEXEC" is used in an item title, and the scheduled begin time for 
that item is reached, the program will automatically be run without waiting for you to reply 
to a prompt. As with "EXEC", the item will be marked as done in the schedule. 
 
Both Windows and non Windows programs, plus batch and command files may be run using 
these commands. If the program is a Windows application, the program window will appear 
in front of any other active windows and will have the focus. If it is a non Windows program, 
the system will automatically switch to the DOS environment to run it. When the program 
ends, the system will switch back into the Windows environment. 
 
Programs and executable files must end in either ".EXE", ".BAT", or ".COM".    For programs 
and executable files with names ending with .BAT or .COM, the .BAT or .COM suffix must be 
included with the name, otherwise the system will not be able to locate the program or file.   
For programs with names ending with .EXE, you do not have to include the .EXE when 
specifying the program name, however .EXE may be included. 
 
Also, the PATH statement in the AUTOEXEC.BAT file must include the directory in which the 
program or file is to be found, unless you specify the path explicitly (e.g.    EXEC    c:\mydir\
backup.bat). 
 
The format for both EXEC and AUTOEXEC is: 
 
<Optional text>    <Keyword>    <Program name>    <Parameters> 
 
<Optional text> is any description you care to put in the item title line.      <Keyword> is 



either    EXEC    or    AUTOEXEC.    <Program-Name> is the    name of the program or 
executable file you want Above & Beyond to load and run.    <Parameters> are any 
information that the program needs to perform properly. 

EXEC Example 

Example Item #1:

Backup    manuscript    EXEC    mybackup.bat    /new b: 
 
In this example, the optional text is a brief description of the function you want to 
accomplish, which is to backup onto diskette the manuscript you have been working on.    
Then, you chose the keyword EXEC so that Above & Beyond will prompt you before it loads 
and runs the file.    This will give you time to put a blank diskette into the drive.    
MYBACKUP.BAT is a batch file you created to make backup copies of the manuscript.    You 
wrote the batch file so that it would copy onto any disk drive you specify.    Here, you have 
specified the parameter,    "B:",    indicating that you want to use drive    B:    this time. 

AUTOEXEC Example

Example Item #2:
 
AUTOEXEC    NOTEPAD 
 
In this example, there is no descriptive text.    You chose the keyword    AUTOEXEC    this time 
because this is a high priority item and the program must run at the specified time.    
Notepad is the name of the program you want to run, and it requires no parameters. 
 
The keywords may be typed in upper case, lower case or mixed cases. Everything that 
follows the keyword is treated as a program name or parameter.    The keyword, program 
name and all parameters must be separated from each other by (only) one space. 
 
The optional text, keywords, program names and parameters are all typed into the Title line 
in the definition dialog box used to create the item, and they will be displayed on the 
schedule in the normal fashion.



Workgroup Use

Summary of Features

1.    You can view and update the schedules of other Above & Beyond users.    Note, however,
that these schedules must be in directories to which you have read and write access.    One 
or more of these schedules can be based on local area network (LAN) servers.    Multiple 
schedules can be viewed on your screen in overlapping windows. 

2.    You can delegate tasks easily by "cutting" items from your schedule and "pasting" them 
into the schedules of co-workers.    

3.    You can check on the status of tasks being performed by others in the group.    If the task
is completed you'll see it marked done; if it is coming up, you can see when the person plans
to get to do it.

4.    You can easily schedule meetings when a group of others (and yourself) are available.    

5.    You can post electronic mail by inserting notes into another person's schedule.
 
6.    A common company phone book may be created which can be accessed by every Above
& Beyond user.    If the company phone numbers are stored in a cardfile named "phone.crd" 
then simply add the following entry to each user's Worktools list:

Company Phone Book cardfile.exe phone.crd

7.    Users can be restricted in accessing and updating the schedules of certain other users.    
This can be done by setting read/write permission through the Network administration 
software already running on your LAN.



Opening Schedules
In order to look at or update the schedules of others, you must first "open" the user; which 
means that their schedules will appear on your screen.    A list of the "open" users is 
displayed in the Schedules menu.    For instructions on how to "open" users, see the section 
on the Schedules menu .



Workload Balancing
Supervisors who assign work can monitor the workload and priorities of each worker in a 
precise way. Above & Beyond schedules show clearly the workload on each day, in 
percentages, amounts, and even graphically with use of color on a Month-at-a-glance view. 

Supervisors know ahead of time when a worker is running out of things to do, or on the other
hand, if too much work is piling up. 

Supervisors can see when workers will be getting to particular tasks, and shift the work 
sequence based on new priorities. 



Status Query
Supervisors can check the completion status of any task at any time, without interrupting 
the worker. The worker doesn't even have to be available, which is important if they are 
working at another location, at lunch, on the phone, out sick, or on another shift. This is an 
enormous time saver. If the supervisor finds the task has not been completed, he can also 
see when the worker has planned to get to it.



Meeting Maker
Meetings for several Above & Beyond users can be planned jointly. The cost of trying to find 
out when everyone in the group is free is normally quite high, because of the amount of time
it takes to interview each person in the group and have them check their schedules, and 
recheck their schedules for alternate slots. That hassle is eliminated with the Meeting Maker 
because anyone with access to all the schedules needed can plan a meeting that is conflict-
free. When a joint meeting is scheduled, the item is posted on the schedules of each of the 
attendees. 

The Meeting Maker feature will find blocks of free time which are common to all Above & 
Beyond users whose schedules are currently open on the screen of the person who is 
scheduling the meeting.    The Meeting Maker will display a list of the users who are open in a
box labeled "Attendees".    For information on how to "open" selected users, see the section 
on the Schedules menu.
 
Enter the title of the meeting as you would like it to appear on the attendees schedules.    
Enter the duration of the meeting if different from the default duration.    Select the 
appropriate check boxe(s) for the day(s) of the week that the meeting can occur.      
 
The "Search Bounds" are the time constraints for when the meeting can be scheduled.    The 
"Start Date" is the earliest date that the meeting could be scheduled.    Enter the desired 
search bounds and start date if different from those shown. 
 
When the "Search" command is selected, Above & Beyond will search the attendees 
schedules for a block of free time of the specified duration, between the search bounds, and 
after the start date.    The first potential meeting date will appear in the box below the 
"Search" command button.    The block of free time which is common to all attendees on that
date will appear in the "Open Range" box.    A suggested begin time will appear in the "Begin
Time" box.    If the open range is longer than the meeting duration, you may specify an 
alternate begin time within the open range. 
 
If the first potential meeting date and open time range is not to your liking, simply select the
"Next" command.    Above & Beyond will search for the next block of free time (of the 
duration specified) which is common to all attendees.    To return to the first potential 
meeting date select the "Search" command again. 
 
When the suggested meeting date and begin time is to your liking, select the "Schedule" 
command and the meeting will be added to each attendee's schedule.    To exit the Meeting 
Maker select    the "Exit" button. 



The Alarms Off Option
When running in a LAN environment and viewing someone else's schedule, you will see their
alarms pop up.    To prevent this, choose "Alarms Off" in the Options menu.    This tells Above 
& Beyond to display only your alarms.    The setting you select for this option on their Above 
& Beyond schedule affects only your viewing of their schedule.    Alarms will still pop-up 
during their Above & Beyond sessions.    This setting is remembered between sessions, so 
you need only issue this command once.



The File Menu
File: Print Today's Schedule
File: Print Range of Schedules
File: Page Size Setup
File: Export Today's Schedule
File: Export Range of Schedules
File: Export Alphabetical Items List
File: Display Log File for Month
File: Name
File: Save
File: View Export File
File: Exit
File: About Above & Beyond



File: Print Today's Schedule

Use this command    to print the current day's schedule, regardless of the schedule 
appearing on the screen. 

A message will appear asking if you would like to print the Extended Outlook.    The Extended
Outlook contains:

1: A three month calendar
2: A listing of highlighted items for the next three months.    
3: A Month at a Glance view of highlighted items for the next three months.

To highlight an item, use the "Highlight Item" command in the Edit menu. 



File: Print Range of Schedules

The Print Range of Schedules command allows you to print out a number of schedules 
between specified dates. 
 
Selecting this command will bring up a dialog box into which you can enter the range of the 
schedules you wish to print.    You can also choose options such as the number of schedules 
that will appear on a page and whether you would like the Extended Outlook printed as well.

In the first area of this dialog box, select the option button labeled "Today" (the present date 
appears to the right of this button) or the option button labeled "Date:" and enter the date of
the first schedule you would like printed. 

In the second area, you may choose how many schedules you would like printed.    Select the
first option button and enter the number of days (schedules) to be printed; or select the 
option button titled "Date:" and type in the date of the last schedule to be printed. 
 
The next area of the dialog box is where you may indicate how many schedules to be printed
per page.    Select the first option button and enter the desired number of schedules per 
page; or select the second option button to have the schedules fill the entire page. 
 
Check the box titled "Extended Outlook" if you would like to print a list    of up-coming 
highlighted events for the next three months.    Select the "OK" command button to have the
schedules printed. 



File: Page Size Setup
 
For printed output, use Page Size Setup to select from a variety of    page height and width 
options.    For example, for Daytimer's appointment books, use 6.75" by 3.75".    Note:    For 
the chronological portion of the Extended Outlook to appear, page width must be at least 
7.25".    Month at a Glance will appear in any size selected.

If you choose Default, the settings from the current printer setup are used.    These are 
selected in the Windows Control Panel.



File: Export Today's Schedule

This command will cause the present day's schedule to be written to a file called 
EXPORT.TXT in the current directory.    



File: Export Range of Schedules

This command will allow you to print a number of schedules to a file entitled EXPORT.TXT in 
the current directory.      The controls on this dialog box are identical to those of "File: Print 
Range of Schedules".    See "File: Print Range of Schedules" for details. 



File: Export Alphabetical Items List

This command will export the alphabetical items list to a text file called "Export.Txt".    You 
may easily view this file by selecting "File: View Export File".



File: Display Log File for Month

Use this command to see the archived items for a particular month.    First go to the month 
you are interested in (by using the calendar or by pressing F9 and typing in any date during 
that month).    Then select File: Display Log File for Month.



File: Name

The Name command will display on the screen the name of the file where the schedule 
information is stored. This is helpful when you have the schedules of several users active on 
the screen at one time. Using this command, you will be able to verify whose schedule you 
are looking at in cases where the person has not entered their name in the banner line.    



File: Save

The Save command will save any changes made during the last minute to the TIMEDATA.PAK
file.    However, since changes are saved automatically every sixty seconds, you need not 
use this command. 



File: View Export File

This command is an easy way to view the export file "Export.Txt".



File: Exit

The exit command will do a "File: Save" and return you to the Windows Program Manager.



File: About Above & Beyond

This command will display information about the program including copyright information 
and version number.



The Edit Menu
Edit: Insert New Item
Edit: Insert Note Item
Edit: Insert Done Item
Edit: Refine Item
Edit: Delete Item
Edit: Delete All Occurrences
Edit: Arrange a Meeting
Edit: Duplicate an Item
Edit: Mark Item Done
Edit: Highlight Item
Edit: Schedule Item
Edit: Start Item
Edit: Start Item After Last
Edit: Cut
Edit: Copy
Edit Paste



Edit: Insert New Item

Use this command to enter new items into your schedule.    A shortcut for this command is to
press "Insert". A dialog box will appear in which you can enter specific information about 
your item.        
 
When you have completed your session in the definition dialog box, select the "OK" 
command button and the item will be inserted into the schedule. 
 
To learn more about inserting new items and the definition dialog box, see the section 
entitled Scheduling".



Edit: Insert Note Item

This command will bring up a definition dialog box for entering a note item into your 
schedule.    Enter the text of the note and select "OK".    The item will be labeled "note" and 
will not conflict with scheduled items nor be calculated into the workload by the color 
utilization calendar. A shortcut for this command is to press ALT+INSERT.

Select the "View" command button in the definition dialog box to display the entire text of 
the note.



Edit: Insert Done Item

For those times when you want to record something you did that wasn't planned, press F10; 
or choose Edit: Insert a Done Item.    This is a shortcut for inserting an item, editing the begin
and end times, and marking it done.    For the begin time, the end time of the previously 
done item is the default.    For the end time, the default is the current time.    Of course, these
default values can be modified if you wish.



Edit: Refine Item

The Refine Item command will allow you to change previously entered information for the 
currently selected item.    A shortcut for this command is to press ENTER or double-click on 
an item in the schedules window.    
 
Selecting this command will open the dialog box which contains the information regarding 
this item that you entered previously.    When you have made the desired changes to the 
data in the dialog box, select "OK". 



Edit: Delete Item

The Delete Item command will remove the currently selected item from the schedule.    A 
shortcut for this command is to press DELETE while in the Schedules window. 
 
If the item you have selected to delete is a recurring item, the "Delete Item" command will 
only remove the item from the schedule you are currently viewing.    To remove all 
occurrences of a recurring item, use the "Delete All Occurrences" command; or delete the 
item from the Alphabetical Items List. 



Edit: Delete All Occurrences

The Delete All Occurrences Item command will remove all instances of a selected recurring 
item from all schedules.    A shortcut for this command is to press CONTROL+DELETE while in
the schedules window. 



Edit: Arrange a Meeting

For details, see the The Meeting Maker in the section entitled "Workgroup Use". 



Edit: Duplicate an Item

The Duplicate Item command will insert a duplicate of the selected item into the schedule 
directly below the selected item.    Shortcut: press double-quote (") while in the schedules 
window. 



Edit: Mark Item Done

The Mark Item Done command will cause a line to be drawn through the selected item.    
Shortcut: press SPACEBAR 
 
Using this command on an item that is already marked with a line through it will cause the 
line to be removed, indicating that the item is uncompleted.    All items must be marked as 
done on a past schedule in order for that day's schedule contents to be archived. 



Edit: Highlight Item

The "Highlight Item" command will cause the selected item to be underlined.    Using this 
command on an item that is already underlined will remove the underline from that item.    A
shortcut for this command is to press F3 from the schedules window. 



Edit: Schedule Item

Using the Schedule Item command on an unscheduled item will make it a (floating) 
scheduled item.    If you wish to specify a particular start time for an item, use the Refine 
Item command an enter a begin time.
      
Using the Schedule Item command on a scheduled item will make it unscheduled.    This 
toggle feature makes it easy to "undo" the command if you desire.    A shortcut for "Schedule
Item" is to press F4 from the schedule window.



Edit: Start Item

With this command (shortcut: F5) the elapsed time of an item in progress can be displayed.   
The Start Item command will start recording the elapsed time associated with the selected 
item.    The elapsed time along with the duration will be displayed on the schedule line. It will
look like this: (:04/:30).    The first number is the actual elapsed time, the second is the 
originally planned duration. 
 
When the item is marked as done, the total elapsed time will be saved and archived along 
with the item.    If you accidentally hit the Spacebar, marking    an item done that is not 
actually done, simply toggle the item to undone (by hitting the Spacebar again) and the 
timing will be restored.
 
If you would like to "restart" a "done" item use the Start Item command again.    The "done" 
item will remain marked as done however a duplicate item will be created and started at the
current time. With this method you have a record of the two (or more) segments of time that
the item was worked on. 
 
The Start Item command may also be used to manually launch an EXEC or AUTOEXEC item 
earlier in the day on which it is scheduled.



Edit: Start Item After Last

With the "Start Item" command (described above), the start time used is the time at the 
moment the command is issued.    With "Start Item After Last" the start time used is the time
when the last done item was finished.    Use this command when you wish to "start" an item 
and indicate that you actually began working on the item when the last item was done. 



Edit: Cut

The Cut command deletes the selected item from the schedule. The deleted item is placed 
in a temporary holding area known as the Clipboard. You can then move the item to another 
Windows application with the Paste command.    You can also move the item to another 
person's schedule.    See also Edit: Paste.
 



Edit: Copy

The Copy command copies the selected item to the Clipboard so that you may duplicate it 
elsewhere using the Paste command.    See also Edit: Paste



Edit Paste

The Paste command inserts the item that is in the Clipboard to into the current schedule. In 
order for the Paste command to be available there must be some text which as been placed 
on the Clipboard via the Cut or Copy commands.

Note: The schedule item will be pasted onto the schedule corresponding to the item's date.   
For this reason, Pasteing items is normally done only when you wish to place the item into 
someone elses schedule.    To copy an item to a different date on your schedule, use the 
Duplicate Item command and then move the copy to the desired date.    See the section 
entitled Juggling Items for information on how to move items to a desired date.



The Select Menu
With a mouse you may select a schedule item by simply clicking on it.    To select a schedule 
for a specific date, you can click on the desired date on the pop-up calendar.

The commands in the Select menu allow you to use the keyboard to select specific 
schedules and schedule items for viewing, editing or juggling.

There are shortcut alternatives to each command in this menu which are very easy to learn 
and use.    The shortcuts are listed to the right of the commands in the menu.    Shortcuts are 
to be used while in the schedules window, and NOT while in a pull-down menu.    To close a 
pull-down menu without selecting any command press the ESCAPE key.

Select: Prior Item
Select: Next Item
Select: Prior Page
Select: Next Page
Select: Prior Schedule
Select: Next Schedule
Select: Today's Schedule
Select: Today's Schedule Undone
Select: Prior Day
Select: Next Day
Select: Prior Week
Select: Next Week
Select: Specific Date
Select: Last Viewed Day
Select: Earliest Undone Schedule
Select: Earliest Undone Schedule Undone



Select: Prior Item

The Prior Item command will select the item above, or prior to, the item currently selected 
on the schedule.    A shortcut for this command is to press the UP arrow key.



Select: Next Item

The Next Item command selects the item below the item currently selected, or the next 
item, on the schedule.    A shortcut for this command is the press the DOWN arrow key.



Select: Prior Page

The Prior Page command will allow you to view the previous page of a schedule that is too 
long to view on one screen.    A shortcut for this command is to press the PAGE UP key.



Select: Next Page

The Next Page command will allow you to view the previous page of a schedule that is too 
long to view on one screen.    In the Select menu, select "Next Page" and press ENTER.    A 
shortcut for this command is to press the PAGE DOWN key.



Select: Prior Schedule

The Prior Schedule command selects the schedule for the date immediately preceding the 
currently selected schedule.    A shortcut for this command is to    press the LEFT arrow key.
 
If viewing multiple schedule windows, the Prior Schedule command will select the schedule 
that appears to the left of the currently selected schedule.    If the left-most schedule is 
selected, the Prior Schedule command will change the schedule in that window to the 
schedule of the previous day.



Select: Next Schedule

The Next Schedule command will select the schedule immediately following the currently 
selected schedule.    A shortcut for this command is to press the RIGHT arrow key.
 
If you are viewing multiple schedules, the Next Schedule command will select the schedule 
to the right of the currently selected schedule.    If the right-most window on the screen has 
been selected, the Next Schedule command will change the schedule in that window to the 
schedule of the next day.



Select: Today's Schedule

The Today's Schedule command will make the schedule for the present day the currently 
selected schedule.    A shortcut for this command is to press the HOME key.



Select: Today's Schedule Undone

Use this command to view just the undone items on today's schedule.    The shortcut for this 
command is: Control+Home.    To again view the done items, simply scroll up (such as with 
the up arrow key).



Select: Prior Day

The Prior Day command will select the schedule for the day prior to the currently selected 
schedule.    A shortcut for this command    is to press the gray MINUS (-) key near the numeric
keypad.



Select: Next Day

The Next Day command will select the schedule for the day after the currently selected 
schedule.    A shortcut for this command is to press the gray PLUS (+) key near the numeric 
keypad while in the schedule window. 



Select: Prior Week

The Prior Week command will select the schedule for the day one week prior to the currently
selected schedule.    A shortcut for this command    is to press F7.



Select: Next Week

The Next Week command will select the schedule for the day one week after the currently 
selected schedule.    A shortcut for this command is to press F8.



Select: Specific Date

The Specific Date command will allow you to specify the exact date of the schedule you 
want to view. A shortcut for this command is to press F9 or simply click on the desired date 
on the pop-up calendar. 

When you select the Specific Date command, a dialog box will be displayed on the screen. 
You may type the date of the schedule you wish to view in the text box. 
 
Type in the date as "month/day/year" with slashes, dashes or spaces between the month, 
day and year.    You may also enter the name of the day of the week for the schedule you 
want ("Tuesday" or "Friday") or a commonly-used abbreviation ("Tues" or "F").



Select: Last Viewed Day

Use this command to view the schedule that was viewed just prior to the schedule currently 
being viewed.

    



Select: Earliest Undone Schedule

The Earliest Undone Schedule command will select the earliest schedule of uncompleted 
items that exists in Above & Beyond.    Archived schedules will not be selected.      A shortcut 
for this command is to press the END key. Remember that all items on a schedule for a past 
day must be marked as done before that schedule will be archived. 



Select: Earliest Undone Schedule Undone

Use this command to view just the undone items of the earliest undone schedule.    The 
shortcut for this command is: Control+End.    To also view the done items, simply scroll up 
(such as with the up arrow key).



The Juggle Menu
The commands in the Juggle menu will allow you use keystrokes to move items within a 
schedule or to different schedules. If you are using a mouse, refer to the section entitled 
Juggling Items. 

When you move a "floating" item up or down on the schedule, the begin time of the item will
adjust automatically.    It is possible to move a "fixed" item up and down on the schedule 
however the begin time you specified will remain the same.    This way you can sequence 
and/or prioritize items to your liking. 
 
If you move an item to a spot where it conflicts with another item or goes outside of the time
bounds you designated, the time will appear grayed warning you of the conflict. 

Juggle: Earlier in Day
Juggle: Later in Day
Juggle: Prior Schedule
Juggle: Next Schedule
Juggle: Prior Week
Juggle: Next Week
Juggle: Carry Over Undone Items
Juggle: Shorter/Longer Duration
Juggle: Earlier Fixed Begin Time



Juggle: Earlier in Day

The Earlier in Day command will cause the selected item to be moved immediately before 
the item that appears above it on the schedule, i.e. earlier than that item.      A shortcut for 
this command is to press CTRL+UP arrow. 



Juggle: Later in Day

The Later in Day command will cause the selected item to be moved beneath the item that 
appears directly below it on the schedule, or later than that item.    In the Juggle menu, 
select    "Later in Day" and press ENTER.    A shortcut for this command is to press 
CTRL+DOWN arrow.



Juggle: Prior Schedule

The Prior Schedule command will cause the selected item to be moved to the previous 
schedule.      A shortcut for this command is to press CTRL+LEFT arrow.
 
If you are viewing schedules in multiple windows, the Prior Schedule command will transfer 
the selected item to the schedule on the left.    However, that schedule may    not necessarily
be the prior day.    If you are viewing multiple schedules and the item you wish to move is in 
the left-most schedule, then the Prior Schedule command will cause the schedule in that 
window will change to the schedule of the preceding day and the selected item will appear 
in that schedule. 



Juggle: Next Schedule

The Next Schedule command will cause the selected item to be moved to the following 
schedule.      A shortcut for this command is to press CTRL+RIGHT arrow.
 
If you are viewing schedules in multiple windows, the Next Schedule command will transfer 
the selected item to the schedule, or window, to the right.    If you are viewing schedules in 
multiple windows and the item you wish to move is in the right-most schedule, then the Next
Schedule command will cause the schedule in that window to change to the schedule for the
next day and the selected item will appear in that schedule. 



Juggle: Prior Week

The Prior Week command will move the selected item back to the schedule one week, or 
seven days, prior to the currently selected schedule.    A shortcut for this command is to 
press CTRL+F7.



Juggle: Next Week

The Next Week command will move the selected item to the schedule one week, or seven 
days, ahead of the currently selected schedule.    A shortcut for this command is to press 
CTRL+F8.



Juggle: Carry Over Undone Items

To move all past undone items to today's schedule, simply press F12, or select Juggle: Carry 
Over Undone Items.



Juggle: Shorter/Longer Duration

To quickly make adjustments to an item's duration without going into the refine screen, 
these shortcuts can be used: Control+Left subtracts one minute from the duration; 
Control+Right adds one minute.



Juggle: Earlier Fixed Begin Time

To quickly make adjustments to an item's begin time without going into the refine screen, 
these shortcuts can be used: Control+Up subtracts one minute to the begin time; 
Control+Down adds one minute.



The View Menu
The options in the View menu allow you to choose how you would like to view your 
schedules: in a single window, in multiple windows or as an alphabetical list.    Check marks 
to the left of the options in the    menu show which options are currently in effect.    See also 
the section entitled Toggling Between Two Views.

View: Single Window
View: Alphabetical Items List
View: Week at a Glance
View: Month at a Glance
View: Multiple Schedules
View: Horizontal
View: Vertical
View: Define Week at a Glance



View: Single Window

Use this command to display one selected schedule at a time.    



View: Alphabetical Items List

Use this command to display a list of all unarchived items in alphabetical order.    Use this list
to find an item if you have forgotten where it is in your schedule. 



View: Week at a Glance

This command will display a week of schedules top to bottom (or side to side) on the screen.
To specify how many (up to 7) and which days of the week you would like to appear, use the 
"Define Week at a Glance" command.



View: Month at a Glance

This command will display the highlighted items for the entire month.    (See Edit: Highlight 
Item for information on highlighted items.)    Here is a tip on how to make the best use of the
relatively small Month at a Glance boxes:

Let the first three or four words of your item descriptions be a concise abbreviation.    Use a 
"Control+Enter" after this abbreviation; then type in the detailed description of the item.    
Above & Beyond will then display just the abbreviated summany in the Month at a Glance 
boxes.    (They will be followed by elipses to indicate that there is more to the item 
descriptions.)

You can scroll the view a week or month at a time in the following ways:

1:    Use the mouse on the vertical scroll bar,
2:    Press the UP or DOWN arrow keys, or
3:    Press the Page UP or Page DOWN keys.

To get a Month at a Glance print out, choose "File: Print Range of Schedules" and choose 
Extended Outlook.    Remember that only highlighted items will appear.



View: Multiple Schedule Windows

The Multiple Schedule Windows command allows you to designate the number of schedules 
(from two to seven) that you would like to view on the screen at one time.    Unlike Week at a
Glance, which displays schedules for a chronological series of days, Multiple Windows allows 
you to display schedules for any dates, in any order, and to manipulate them independently 
from one another.    In the View menu, press M to choose the currently selected (checked) 
number of multiple windows; or type the digit representing the number of windows you 
would like displayed.

When the scheduler is first run on a new day, two schedules may automatically appear on 
the screen: one schedule containing items that have not been marked as completed; and 
the schedule for the present day.    This will call your attention to the uncompleted items on 
the past day so that you may reschedule them if necessary or mark them completed.    
Having the two schedules displayed makes it possible to move items over to the next day by
dragging them    with a mouse.    You can also use the Carry Over Undone Items command in 
the Juggle menu or the "right mouse button" technique explained in the Calendar section. 



View: Horizontal

With the Horizontal command, you tell the scheduler that, when more than one schedule is 
simultaneously displayed (either in Multiple Windows or Week at a Glance), you want those 
schedules tiled side by side, across the screen. 



View: Vertical

With the Vertical command, you tell the scheduler that, when more than one schedule is 
simultaneously displayed (either in Multiple Windows or Week at a Glance), you want those 
schedules to be tiled, one above the other, on the screen. 



View: Define Week at a Glance

The Define Week at a Glance command is used to specify which days of the week will appear
simultaneously when you issue the Week at a Glance command. 
 
A dialog box will appear in which you will specify the desired days of the week      When the 
options are set the way you want them, select "OK".    The Week at a Glance will be 
displayed.



The Worktools Menu
The worktools menu provides easy access to the accessories and applications you use most. 
For example, the Windows Cardfile, Notepad and Calculator.    You may edit the worktools list 
to taylor it to your needs by choosing "Edit Worktools List".

Users of previous versions of this scheduler will have data (such as phone numbers) stored 
in ".NBK" files.    These files can be read directly by Windows Cardfile.    Initially, the first entry
in the Worktools list ("Phone book") is set up to read in the file FIRST.NBK.    Choosing "Edit 
Worktools List", you may easily change FIRST.NBK to another file if you desire.

If you have other ".NBK" files you wish to access, add an entry (similar to the Phone book 
entry) to the Worktools list for each of the files.    They will then appear in the Worktools list 
and can be accessed with a simple mouse click.    



AutoDial
When this command is selected, a dialog box will appear on the screen.    The first area of 
the dialog box is a text box labeled "AutoDial:"

Above & Beyond will search the currently selected item's description for a phone number.    If
there is more than one phone number, it will display the first one.    You may make changes 
to the number before dialing.    If there is no phone number found, you may type in the 
phone number you would like dialed.

The "Tone" and "Pulse" option buttons enable you to chose the type of dialing to be done.      
The "COM1", "COM2", "COM3", and "COM4" option buttons enable you to select the serial 
port that your modem is set for. 
 
When all the information in the dialog box is correct, select "OK" and the number will be 
dialed. 



The Pop-up Calendar

With the pop-up calendar you can quickly display the schedule of any date from 1987 to 
2068.    You may also instantly move any schedule item to any date.

To view the calendar press ALT+C (or click on "Calendar" in the main menu bar),    then 
select "Open".    The first time the calendar is used, it will appear in the upper right corner of 
the screen and the date of the currently selected schedule will be highlighted.    The title bar 
of the calendar will be colored to indicate that this window currently "has the focus" (i.e. 
keystrokes will be directed to this window).    To change the focus between the calendar 
window and the schedules window, press TAB.

Using the calendar and a mouse, selected schedule items may be quickly moved to any 
date.    Select the item to be moved, then click on the target date (on the calendar) with the 
RIGHT mouse button.    This will move the item to that date.

Calendar: Moving & Sizing
Calendar: Selecting Months
Calendar: Selecting Schedules
Calendar: Color Utilization



Calendar: Moving & Sizing

The calendar window has its own Control menu (press ALT+SPACEBAR when the calendar 
has the focus).    Use the Size command to change the size of the calendar and the Move 
command to move the calendar to different places on the screen.
 
The size and location of the calendar will    normally be saved along with schedule changes.   
If a size or position change is the only change made however, use the File:Save command to
retain this information across scheduling sessions.

Note:    When manipulating the calendar with the keyboard keys, the calendar must have the
focus.    Use the TAB key to switch the focus between the calendar and the main schedules 
window. 



Calendar: Selecting Months

To display the previous month on the calendar, you can either press the UP arrow key while 
the calendar has the focus, click on the UP arrow at the top of the calendar scroll bar. 
 
To display the next month, either press the DOWN arrow key while the calendar has the 
focus, or click the DOWN arrow at the bottom of the calendar scroll bar. 
    
To view the calendar for the currently displayed month in the prior year, press PAGE UP, or 
click in the gray area in the scroll bar between the UP arrow at the top of the calendar scroll 
bar and the scroll box (the white rectangle in the scroll bar). 
 
To view the calendar for the same month one year ahead, press PAGE DOWN, or click in the 
gray scroll bar area between the scroll box and the DOWN arrow at the bottom of the 
calendar scroll bar. 
 
You can also leap many years forward or backward easily by dragging the calendar scroll box
up or down within the scroll bar.    The scroll bar represents the entire range of possible 
schedules from April 1986 to December 2068.    You can jump to the middle of the calendar 
range, using a mouse, by dragging the scroll box to the middle of the gray area in the 
calendar scroll bar. 



Calendar: Selecting Schedules

Press the gray minus (-) key in the numeric key pad area to select the previous day, and 
press the gray plus (+) key to select one day ahead of the currently selected day.    As days 
are selected, they'll be displayed immediately in the schedules window.    Notice that the 
dates prior to today are crossed-out on the calendar. 

With the calendar in "standard" viewing mode ("color utilization"    not selected), you can 
easily toggle between the schedules for two dates, using the calendar and mouse.    Click on 
a date in the calendar with the left mouse button to display the schedule for that date.    If 
you click again on that same date on the calendar, the displayed schedule will switch back 
to the previously displayed schedule. 



Calendar: Color Utilization
 
By selecting Color Utilization in the Calendar menu, you can see at a glance, how full each of
your daily schedules is; within an entire month. On the    calendar, each day in the month 
has a background color ranging from green to yellow to red. Pure green indicates a day that 
has no scheduled items. Pure yellow indicates a day that is 50% scheduled.    Pure red 
indicates a schedule that is 100% full. 
 
Days in the past which have been archived and current or future days which have no items 
or items whose total duration is zero appear gray. The utilization is based on the length of 
your day as specified with the "Set New Item Defaults" in the Option menu.



The Pop-up Timer
With the Timer, you can easily time phone calls, meetings, or any other item. The Rate 
feature enables you to associate a value with the elapsed time (e.g. the cost of a telephone 
call or the charge for a consultation.) 
 
To activate the timer, click on Timer in the main menu bar, or press ALT+T (when the main 
window has the focus).    When the Timer window comes up, its title bar will be colored to 
indicate that the timer window currently has the focus (i.e. commands and keystrokes will be
directed to    this    window).    
 
Looking at the timer window, you can see that there is a Rate box, option buttons for 
"/Minute" and "/Hour", and Start, Stop and Reset buttons. Along the bottom of the window, 
are three number groups. The leftmost number is the current time of day. The middle 
number is the monetary value of the elapsed time based on the rate. The rightmost number 
is the actual elapsed time. 

Timer: Start, Stop, Reset
Timer: The Rate Feature
Timer: Focus To & From
Timer: Moving



Timer: Start, Stop, Reset

To start the timer, click on the Start button, or press ALT+S (when the timer window has the 
focus). 

To stop the timer, click on the Stop button, or press ALT+P.    The timer can be stopped, then 
started again without having to be reset and it start counting from the previously 
accumulated time and value. 

To stop the timer and reset the elapsed time and accumulated value to zero, click on the 
Reset button, or press ALT+E. If this is done accidentally, simply Reset again and the time 
and value figures are recalled.    



Timer: The Rate Feature

When entering the desired rate, up to six digits can be used plus a decimal point (period) to 
separate dollars from cents.    Values can accumulate up to 100,000. 
 
When the rate value is entered, click on (or press the TAB key to move the cursor over to) 
the Minute/Hour option buttons. Use the UP and DOWN arrow keys to select either the 
/Minute (per minute) or the /Hour (per hour) option.    Or you can press ALT+M to select 
/Minute or ALT+H to select /Hour. 



Timer: Focus To & From

The simplest way to move the focus from one window to another is to click with a mouse 
anywhere inside the desired window. 
 
Without a mouse, to move the focus from the main window to the timer window, press 
ALT+T. 
 
To change the focus from the timer window to the schedule window, pull down the timer 
Control menu then press S (for Switch window). 



Timer: Moving

As with any other window, you may position the timer in any desired location on the screen. 
The location of the timer will be retained across scheduler sessions.    If you are not familiar 
with the procedure for moving windows refer to Windows documentation regarding the 
Control menu .



The Options Menu
The commands in the Options menu will allow you to enter new default settings, delete the 
sample items, enter your name as you would like it to appear in the title bar and on printed 
schedules, and order a program licence.

Options: Set New Item Defaults
Options: Delete Sample Items
Options: Enter Name
Options: Order an Above & Beyond License
Options: Order a Pre-paid Above & Beyond License
Options: Order an Upgrade
Options: Enter User ID
Options: Alarms Off
Options: Technical Support



Options: Set New Item Defaults

The Set New Item Defaults command will allow you to specify the duration and time bounds 
default settings that will appear each time the definition dialog box is displayed for a new 
item.    
 
When the Set New Item Defaults command is selected, a dialog box will be displayed.    The 
first text box is labeled "Duration".    Type in the amount of time you wish to appear 
automatically as the duration for your scheduled items. 
 
The next text boxes are labeled "Earliest" and "Latest".    Type in the earliest and latest times
that you wish to appear as the bounds in the definition dialog box. 



Options: Delete Sample Items

The Delete Sample Items command will remove the sample items from the schedules. 



Options: Enter Name

Selecting the Enter Name command will cause a small dialog box to be displayed.    Type 
your name in the text box as you would like it to appear on printed schedules and in the 
window's title bar. 



Options: Order an Above & Beyond License

Use this command to become a registered user. Selecting this command will bring a dialog 
box to the screen.    Enter your name and address and how you were introduced to this 
program. Use TAB to move from line to line within the dialog box. 
 
To print the order forms, TAB to the "Print" button and press ENTER.    Send both order forms 
and your check to the address on the form.    You will    receive your user ID in approximately 
two weeks.      
 
Select "OK" remove the dialog box from the screen. 



Options: Order a Pre-paid Above & Beyond License

Use this command to order a license if you have already paid for it, such as through a retail 
store or dealer. Selecting this command will bring a dialog box to the screen.    Enter your 
name and address and how you were introduced to this program. Use TAB to move from line 
to line in the dialog box. 
 
To print the order forms TAB to the "Print" button and press ENTER.    Please send both order 
forms to the address on the form.    You will receive your user ID in approximately three 
weeks.      
 
Select "OK" to remove the dialog box from the screen. 



Options: Order an Upgrade

This option is available only to registered users of a previous release. Registered users can 
purchase a license for the upgraded version at a reduced price. Upgrades offer major 
enhancements, while updates offer incremental improvements of the current version.    
Updates are free to registered users. 



Options: Enter User ID

When you receive your user ID from 1Soft in response to your registration order, select the 
Enter User ID command. Type your user ID into the text box that appears. The word "VALID" 
should appear. 
 
If "VALID" does not appear, check the name that appears in the window's title bar.    The 
name in the title bar should be exactly the same name that printed on your order form as 
the licensee.    If it is not the same, you may correct it using the Enter Name command in the
Options menu. 



Options: Alarms Off

When running in a LAN environment and viewing someone else's schedule, you will see their
alarms pop up.    To prevent this, choose "Alarms Off" in the Options menu.    This tells Above 
& Beyond to display only your alarms.    The setting you select for this option on their Above 
& Beyond schedule affects only your viewing of their schedule.    Alarms will still pop-up 
during their Above & Beyond sessions.    This setting is remembered between sessions, so 
you need only issue this command once.

Alarms Off will also prevent Exec and Autoexec items in another person's schedule from 
being launched on your workstation while you're accessing their schedule.    

The Alarms Off option may be toggled by simply selecting the command once again.



Options: Technical Support

This command will display the 1Soft technical support telephone number and hours.



The Schedules Menu
Use the schedules menu to quickly switch between the schedules of workgroup members.

The schedules list is divided into two sections.    The upper section lists the schedules who 
are currently "open".    The lower section lists all the users available on the network, open or 
not.

To view the schedule of an "open" user, click on their name in the upper section.    (Do not 
click on their name in the lower section or a duplicate instance of their schedule will be 
opened.    If this occurs, simply close one of their schedules before proceeding.)

To bring up the schedule of a user who is not open, click on their name in the lower section.   
This adds their schedule to the "open" list in the upper section.    

Use the Edit Schedules List command to add/remove users to/from the list (USER.LST) of 
network users displayed in the lower section.    The following is a sample USER.LST:

Michael C:\michael\michael.pak
Christy    J:\christy\christy.pak

"Michael" and "Christy" will appear in the schedules list; and Above & Beyond will look for 
their schedules in the files specified following the TAB.    Note:    A ".pak" extension may be 
omitted as this is the default.



Technical Support
Free telephone technical support is available Monday through Friday by calling 707-987-
0256 during the hours listed below for your time zone:

Pacific U.S.: 8am - 4pm Mon - Fri
 

Mountain U.S. 9am - 5pm Mon - Fri

Central U.S.: 10am - 6pm Mon - Fri
 
Eastern U.S.: 11am - 7pm Mon - Fri

United Kingdom: 4pm - Midnight Mon - Fri

Western Europe: 5pm - 1am Mon - Fri

Sydney, Australia: 2am - 10am Tue - Sat

Hawaii: 6am - 2pm Mon - Fri

Besides telephone technical support, help is also available on CompuServe.    Messages can 
be addressed to CIS ID 71240,1625.    Many of the participants on the WINADV, WINAPA, 
and IBMAPP forums are Above & Beyond users.


